
Pen Tool Power

W e all have certain “to do” chores that we keep putting off. For me, it’s sort-
ing through seemingly endless contact sheets and strips of negatives from 
college. For my husband John, just the idea of sorting through dusty golf 

clubs and the possibility of parting with a never-used putter brings on cold sweats. 

I also used to have a list of “to learn” chores in Adobe Photoshop. I worked with 
Photoshop for three years before I touched Curves, and it took me even longer to get 
up the nerve to learn how to use the Pen tool. Every time I tried to use it, the Pen tool 
and I ended up having a fight, and in most cases, the Pen tool won. If tangled Pen tool 
loop de loops covering your image sound familiar, then you know what I mean. 

Learning the fundamental power of the Pen tool takes about 90 minutes. Just 90 min-
utes, and you’ll be able to use one of the best selection tools in Photoshop. 

In this chapter, you’ll learn how to

●● Recognize the types of images that make ideal Pen tool candidates

●● Use the Pen tool to silhouette simple and complex objects

●● Work with paths, the Paths panel, and the Path Selection tools

●● Combine paths and selections
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Pen Tool Essentials
The Pen tool is not a drawing or calligraphy tool that 
lays down ink; rather, it is a mechanical drawing tool 
used to precisely outline an object or define a smooth 
curve with anchor points and mathematical vector 
curves. The vector aspects of the Pen tool enable it to 
work independently from the pixel information of the 
underlying image, which is exactly why the outlines 
created with the Pen tool are much smoother than 
outlines created with a pixel-based selection tool, as 
illustrated in Figure 1. 

On the top is a picture frame that Katrin found along 
the rocks of the Hudson River that she selected as 
carefully as possible with the Quick Select tool with 
the Auto-Enhance check box selected. As you can see, 
the edges aren’t smooth. On the bottom is the same 
frame, but this time she used the Pen tool to outline 
it. The edges are smooth and flowing without any tell-
tale lumps or bumps that working with a pixel-based 
selection tool can create. We suppose that the best 
results would have been for Katrin to carry the frame 
home and photograph it on a white seamless, but she 
preferred not to drag home debris from the Hudson 
River!

Pen Tool Settings
Before you use the Pen tool to outline an image 
subject, it is important to review the settings in the 
Options bar to ensure that they are set up ideally for 
photographic purposes, meaning to create accurate 
outlines versus shape-based layers. On the Pen tool 
Options bar (Figure 2) and working from left to right, 
you see:

●● Pick Tool Mode. Choose Path from the Pick Tool 
Mode menu. 

●● The Make options. Selection, Mask, and Shape are 
inactive and not required before making a path.

●● Path operations. Determine how a path and the 
ensuing selections will behave in relation to combin-
ing, overlapping, intersecting, and excluding paths 
and selections. 

When to Use the Pen Tool
At first glance, the Pen tool doesn’t look like a selec-
tion tool: It’s not located on the toolbar with the other 
selection tools; it doesn’t create a dancing marquee 
outline when you use it, and it doesn’t respond to the 
Select menu commands. So is it even a selection tool? 
Absolutely. 

The Pen tool works well for selecting shape-based and 
form-based image elements. For example, you’ll use 
the Pen tool in the following situations:

●● To select smooth, mechanical edges, such as build-
ings, cars, bottles, windows, and so on.

●● To select smooth, organic forms, including rocks, 
nudes, fishes, flowers, planets, and so on.

●● To select elements in images where the color and 
tones are so similar that the standard selection tools 
aren’t different enough to create an accurate selection.

●● To silhouette an object by dropping out the image 
background.

●● Most important, when you need extreme precision. 
It is exactly in this situation where the Pen tool stands 
out among the other selection tools.

Do not use the Pen tool to select image elements with 
the following characteristics:

●● Images with delicate or complex detail, such as 
puffy dandelions or winter tree branches

●● Portraits of people with fine hair or furry animals

●● Images with tonal subtle gradations, such as a sun-
set, water reflections, or a foggy landscape

●● Areas in an image with soft edges, such as a natural 
shadow or photographic motion blur

Once you have created a path, you can turn it into a 
selection to use for a mask or composite, or to create 
a path for any painting tool to follow. In other words, 
the Pen tool is an end to a means; use it to make exact 
outlines of form-based and shape-based objects, and 
control where image effects take place. 
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●● Path alignment. Determines how paths are 
aligned and is used when drawing shapes or design-
ing a vector-based subject, such as a logo, which in all 
honesty is better done in Adobe Illustrator.

●● Path arrangement. Controls how shapes are 
stacked.

●● Rubber Band. Allows you to see the connecting 
path as you draw our to the next anchor point. It is a 
very useful option, and we recommend you turn it on 
by default. 

●● Auto Add/Delete. Allows you to add an anchor 
point to a path when hovering over a path or delete 
an anchor point when hovering over an anchor point. 
Pressing Command+Option (Ctrl+Alt) also reveals 
the context-sensitive menu where you can select to 
add or delete anchor points. 

The three options we recommend photographers 
use are Choose Paths, Rubber Band, and Auto Add/
Delete. With Photoshop CS6, the improved function-
ality of the Options bar has essentiality replaced the 
dedicated Paths panel. The primary reason we still 
use the Paths panel is to name our paths, but more on 
that later in this chapter.

Clicking and holding the Pen tool in the toolbar 
reveals the standard and Freeform Pen tool, and the 
Add, Delete, and Convert Point tools (Figure 3):

●● Pen tool. Use this tool to make very precise selec-
tions by creating a path of adjustable anchor points 
(press Shift+P to cycle between the Pen tool and 
Freeform Pen tool).

●● Freeform Pen tool. Use this tool to make custom-
ized paths that are not straight by default. The path/
selection follows the same path as your mouse. This 
tool is not particularly useful for precise photo com-
positing (press Shift+P to cycle between the Pen tool 
and Freeform Pen tool).

Figure 1  The top frame was selected with the Quick Select 
tool, whereas the much smoother selection in the lower 
frame was made with the Pen tool. © KE

Pick Tool Mode

Auto Add/Delete

Rubber Band

Make Options Path Operations Path Arrangement

Path Alignment
Figure 2  Essential Pen tool options.
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Straight Paths
Working with the Pen tool is akin to the childhood 
game of connecting the dots to reveal the picture; 
the only issue is that the dots aren’t on the paper. The 
“dots” are the anchor points that you add with a single 
click of the Pen tool. By clicking around an object 
from point to point without holding down the mouse 
button, you create a path defined by a series of corner 
points and straight lines. To practice along, download 
the templates from www.peachpit.com/pmc2e.

	 �pentool_lessons.zip 
1_pentool_square.jpg

Start in the upper-left corner, and working from 
corner to corner, click once on each corner to add an 
anchor point. When you return to the initial anchor 
point, a small circle will appear next to the Pen tool. 
This is the symbol to close the path. Click once more 
on the first anchor point to close the path. Open the 
Paths panel to verify that Photoshop has added a 
Work Path, as shown in Figure 5. Double-click Work 
Path to rename the path. 

●● Add Anchor Point tool. Inserts anchor points 
along a path. Anchor points can be used to alter lines 
without redrawing them.

●● Subtract Anchor Point tool. Deletes anchor points 
from a path.

Pen Tool Partners
Allow us to jump ahead for a moment: After creat-
ing an initial path, you may need to move or refine it, 
and the primary tools to do that are the Path Selec-
tion tool (A) and Direct Selection tool (A), which are 
below the Type tool on the toolbar. The Path Selec-
tion tool, also referred to as the black arrow, moves 
entire paths. The Direct Selection tool (white arrow 
tool) allows you to refine the placement of individual 
anchor points and refine direction handles.

With the Pen tool active, press Command+Option 
(Ctrl+Alt) to activate the Path Selection tool and 
Command (Ctrl) to activate the Direct Selection tool. 
Or if all these modifiers make your fingers ache, sim-
ply press A to activate the last used Pen tool selection 
tool and Shift+A to cycle through the Pen tool selec-
tion tools (black or white arrows).

With either the Path Selection or Direct Selection 
tool active, you’ll see the new to Photoshop CS6 
Constrain Path Dragging option in the Options 
bar (Figure 4). By default, dragging with the Direct 
Selection (white arrow) tool adjusts multiple related 
segments, letting you quickly transform path shapes. 
To edit only segments between selected anchor 
points, reflecting earlier versions of Photoshop, select 
Constrain Path Dragging in the Options bar.

Figure 3  Nested Pen tools.

Figure 4  Constrain Path Dragging is available with the Path or Direct Selection tool.

Figure 5  Start out by making a square before moving onto 
the curved objects.
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	 	 tip   Press Shift to constrain angles to 45 degree 
increments.

Creating a path for each separate card or image ele-
ment gives you greater flexibility when you’re select-
ing the individual image elements. Your final result 
should be the camera cards image with four separate 
paths, as shown in Figure 7. 

	 	 tip   To create extremely precise paths, zoom in 
to a 200% to 300% view and stay one pixel inside of the 
object you’re selecting.

Figure 6  You may be asked to isolate basic forms, such as 
these camera cards. © KE

Photoshop can support up to 32,000 paths (a mind-
boggling concept). Naming paths takes only a 
moment, but it is extremely helpful in navigating the 
Paths panel with ease. Naming the Work Path also 
ensures that it will not be overwritten when you start 
a new path.

Outlining square or rectangular subjects is a good 
way to build up your Pen tool skills and confidence. 
Before you start, check that the Pen tool options are 
set to Path, select Rubber Band, and stay just slightly 
inside of the object by one pixel to start outlining. 
Click from point to point or corner to corner to 
outline straight-edged objects, such as the individual 
compact flash cards in Figure 6. 

	 cameracards.jpg

1.	 Start by outlining the upper-left card by clicking 
on each corner.

2.	 After closing the path, open the Paths panel and 
name the Work Path upper left.

3.	 To create a separate path outline for the upper-
right card, it is very important that the upper-left 
path is not active—that is, not highlighted in the 
Paths panel. Deactivate the upper-left path by clicking 
in the neutral gray area under the named path in the 
Paths panel. 

4.	 Outline the next camera card and name the path.

5.	 Repeat the process for the remaining two cards.
Curved Paths
Using the Pen tool to outline straight-edged objects 
is a good place to start learning, but when it comes to 
outlining curved objects, the Pen tool really shines. 
To create a curved path, click and hold down the 
mouse button while dragging in the direction of the 
next anchor point along the edge that you are outlin-
ing. The initial anchor point changes from an anchor 
point to a smooth anchor point, with direction lines 
and direction points that control the curve. While 
drawing the initial path, ignore the direction points 
and concentrate on where you’ll place the next anchor 
point. After you’ve closed and named the path, return 
to the path to move the direction points and anchor 
points to refine the path as addressed later in this 
chapter.

	 2_pentool_circle.jpg

Figure 7  Each camera card has a dedicated and named 
path. 
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Let’s practice outlining a curved object using the 
circle practice template.

1.	 Start on the top dot (at the 12 o’clock position) and 
click, hold, and drag to the right.

2.	 At the tip of the arrow, release the mouse. 

3.	 Move the mouse to the second dot at the 3-o’clock 
position and click once.

4.	 Release the mouse and click and hold on the third 
dot (at the 6-o’clock position).

5.	 Drag the mouse to the left, and you’ll see how 
beautifully the curve is describing the circle. 

6.	 Release the mouse and click the third dot (at the 
9-o’clock position), and then release the mouse.

7.	 Return to the initial anchor point and click once 
on the first anchor point to close the path. 

8.	 Open the Paths panel to see that Photoshop has 
added a work path, as shown in Figure 8. Rename the 
path to convert the temporary work path into a more 
stable entity that will not be replaced and that you can 
refine as needed. 

Figure 8  The fewer points used, the smoother the curve 
will be. 

Hints for Pen Tool Success

Over the years we’ve developed and used these 
hints to help make us better Pen tool users:

l	 Use as few anchor points as possible.

l	 Place anchor points as far apart as possible.

l	 Place anchor points at significant changes in 
curvature inflection.

l	 While drawing the initial path, pull the handle in 
the direction you want to continue the path.

l	 The handles that define the curve should not be 
longer than half the length of the curve they are 
describing.

l	 Close the path before going back to fine-tune 
anchor points or handles.

l	 Name all paths.

l	 Before creating an additional path, double-check 
the Paths panel to make sure no other path is active. 

l	 Work at 200% to 300% view and stay one pixel 
within the object to be selected. 

l	 Learn the essential Pen tool command keys.

l	 While making a path, use the Pen Tool mantra, 
“click, hold, drag,” to meditate yourself into a calm 
Pen tool mind-set.

l	 With one eye, look ahead along the path to see 
where the next anchor point should go. This is akin 
to driving on the highway—you don’t concentrate 
on the asphalt 10 feet in front of your car but rather 
look ahead to observe the traffic flow.

l	 Do not fight the Pen tool; it will win. If the Pen 
tool is winning and your curves and handles look like 
a plate of spaghetti, press the Delete key twice to 
delete the offending path, take a deep breath, smile, 
and start over again. 

l	 Remain calm; the Pen tool is very forgiving. It 
doesn’t race back to the starting point like the Lasso 
tool, and it doesn’t create unpredictable selec-
tions like the Magic Wand. Carefully click your way 
around the object, knowing that you can always 
return to a specific point to fine-tune the anchor 
point after closing the initial path.
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Figure 9  Practice tracing straight and curved subjects to 
hone your Pen tool skills.

As you can see, it only takes four anchor points to 
describe a complete circle. Take this tidbit of informa-
tion with you as you work with the Pen tool, and use 
as few anchor points as possible to outline an object. 
The goal is not to rivet around the object but to grace-
fully and efficiently outline an object, which you can 
do with just a few anchor points. 

Combining Curves and Corners
Most of the objects you’ll need to outline won’t be 
perfect squares or circles. The following exercise 
shows you how to make a path with both curved lines 
and sharp corners. 

	 3_pentool_curves-corners.jpg

Using the practice template, follow these steps:

1.	 Start at the top-left corner and click, release the 
mouse button, and click the junction of the curve to 
the right.

2.	 Release the mouse and click the apex of the curve, 
hold down the mouse button, and drag to the right 
to define the curve on the left side of the arch. Notice 
how the angle and length of your drag changes the 
shape of your curve.

3.	 Release the mouse button and click the junction 
where the arch meets the angle.

4.	 Click once on the corner point and continue work-
ing your way around this shape (Figure 9).

5.	 Return to the initial anchor point and click once 
on it to close the path. 

	 	 tip   To practice your Pen tool skills, outline the 
letters Z, B, and S, and trace the additional templates 
provided in the Pentool_lessons folder.

The gray boat in Figure 10 is a perfect image for the 
Pen tool. It is a man-made, hard-edged object, and it 
doesn’t have strong tonal or color differences you can 
use to separate the boat from the background.

	 �gray-boat.jpg 
gray_boat_dots.jpg 

Figure 10  The overcast light and the gray boat on the gray 
pier make this subject an ideal candidate for the Pen tool. 
© SD

Take a moment to plan ahead and visualize where 
you will place the anchor points. In Figure 11, Katrin 
added dots to show where she would place anchor 
points. Those points are where there is a dramatic 
change in direction, like the ribbing, and where the 
curve is distinctly defined. For best results, work 
between 200% and 300% zoom view. As you can see 
in Figure 12, you’ll only see part of the boat. Once 
you’ve clicked, held, and dragged your way toward 
the edge of the visible image, hold down the spacebar 
to access the Hand tool and scroll to the rest of the 
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3.	 Continue down and around the boat, being careful 
to stay just inside of the edge by one pixel between the 
boat and the background. 

4.	 When you reach a corner point, press Option (Alt) 
while clicking and dragging along the edge to add a 
corner anchor point with direction handles that you 
can fine-tune after you’ve closed the path. 

5.	 Work your way around the boat and back to the 
origin point of the path. Click the initial anchor point 
to close the path. 

6.	 Open the Paths panel and name the path Boat, as 
shown in Figure 13.

	 	 tip   Use Katrin’s Pen tool mantra to keep track 
of where you are while creating your first paths: “Click, 
hold, drag. Click, hold, drag. Click, hold, drag.” This will 
help you to become a smooth, confident, and very calm 
Pen tool master. 

In a nutshell, sharp 90-degree corners require one 
click; curves require a click, hold, and drag to form a 
smooth contour; and changing direction requires that 
you either double-click or Option-click (Alt-click) an 
anchor point to draw out a direction handle as you 
make the path.

image. As soon as you release the spacebar, the Hand 
tool will revert back to the Pen tool, and you can 
continue working.

Start with the gray_boat_dots.jpg file, and then prac-
tice creating the path on the gray_boat.jpg file without 
the dots. 

1.	 Starting at the top of the boat, click, hold, and drag 
to the right. While dragging the handle to the right 
and along top of the boat, look ahead and plan where 
your next anchor point will be.

2.	 Release the mouse button and move the mouse to 
where the second anchor point should be. Click, hold, 
and drag along the white canvas.

Figure 11  Look at the object 
and imagine where you would 
place the dots—that is, the 
anchor points to plan out the 
path.

Figure 12  Use the spacebar to access the Hand tool and 
scroll the image into view.
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arrow tool), which is underneath the Type tool in the 
Tool bar. When you’re initially creating and refining a 
path, the active anchor point is solid and an inactive 
point is hollow.

To refine a path with the Direct Selection tool:

●● Move anchor points so that the path outline con-
forms to the object more precisely. 

●● Move direction handles up and down in a seesaw 
manner to make the angle of the curve steeper or 

Fine-tuning a path
After you close a path, inspect it to see whether the 
outline needs to be finessed. Zoom in and take a close 
second look at the boat path (Figure 14). Look for 
sections of the path that are outside or too far inside 
of the boat. 

To fine-tune the path, use the Direct Selection tool, 
fondly called the white arrow tool, to move anchor 
points and adjust direction handles (Figure 15). You’ll 
find it nested under the Path Selection tool (the black 

Figure 13  Close and name the 
path before fine-tuning the path.

Figure 14  The initial path is all right, but it needs 
refinement before it looks professional.

Figure 15  Refine the path with the Direct Selection tool.
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●● Change the attributes of anchor points as needed. 
To convert an anchor point to a smooth anchor point, 
use the Direct Selection tool and Command+Option-
drag (Ctrl+Alt-drag) to pull out the handles. To con-
vert a smooth anchor point to an anchor point, use 
the Direct Selection tool and Command+Option-click 
(Ctrl+Alt-click) the anchor point to convert it.

Refining a path with Free Transform:

●● To transform the size or shape of the entire path, 
use the Path Selection tool (black arrow) to select the 
path by clicking anywhere on the path. Choose Edit > 
Free Transform Path to scale the path. Control-click 
(right-click) to open the Transform context menu to 
access all of the Transform options: Scale, Rotate, 
Skew, Distort, Perspective, Warp, Rotate 180 and 90 
degrees, Flip Horizontal and Flip Vertical.

●● To transform a group of points on a path, use the 
Direct Selection (white arrow) tool to click and drag 
over a number of adjacent points. Choose Edit > Free 
Transform Path to scale just part of the path.

When you’re working with the Pen tool and paths, use 
the command keys in Table 1 to make your Pen tool 

to bend them into a form-fitting position. You won’t 
need to move the handles very much to achieve dra-
matic results. 

●● If a curve is too steep, shorten the direction lines by 
pushing the direction handles in toward their anchor 
point. 

●● To increase the arch of a curve, lengthen the direc-
tion lines by pulling them away from the anchor point. 

●● Move direction handles independently to affect 
only the curve on one side of the anchor point by 
Command+Option-clicking (Ctrl+Alt-clicking) one 
handle and pulling. 

●● If the handles are longer than half the length of the 
curve that they describe, add a new anchor point by 
Control-clicking (right-clicking) the curve where you 
need a new anchor point. Then choose Add Anchor 
Point from the context menu.

●● If there are too many anchor points, simplify the 
path by deleting unnecessary anchor points. Use the 
Direct Selection tool and Control-click (right-click) 
over an existing anchor point and choose Delete 
Anchor Point.

Table 1  Pen Tool Command Keys

Task Action

Activate Pen tool and Freeform Pen tool P

Switch between Pen tool and Freeform Pen tools Shift+P

Toggle between Pen tool and Direct Selection tool Command-click (Ctrl-click)

Toggle between Pen tool and Hand tool Press and hold the spacebar

Move individual handles Command-click-drag (Ctrl-click-drag)

Convert anchor points Option-click (Alt-click) the anchor point

Select multiple anchor points Command+Shift-click (Ctrl+Shift-click) on desired anchor points

Select entire path Command+Option-click (Ctrl+Alt-click)

Duplicate a path Command+Option-drag (Ctrl+Alt-drag)

Delete anchor point Control-click (right-click) to open context menu

Add anchor point Control-click (right-click) to open context menu

Close an open path Click first open end and then the second

To continue a path Click open end and continue the outline

Constrain to 45° increments Shift (Shift)

Path Selection and Direct Selection tool A (Shift+A)

Activate Last Used Selection tool Command (Ctrl) 

Select Convert Direction Point tool Option (Alt)
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●● Width determines how far to the left or right the 
Magnetic Pen tool will look for a line to follow. Press 
the Caps Lock key to turn the Magnetic Pen tool icon 
into a circle whose size reflects the width, and press 
the left or right bracket key to decrease or increase 
the width diameter.

●● For Contrast, enter a percentage value between 1 
and 100 to specify the contrast required between the 
pixels to be considered an edge. Use a higher value for 
low-contrast images.

●● For Frequency, enter a value between 0 and 100 to 
specify the rate at which the Pen sets anchor points. 
Higher values anchor the path in place more quickly.

●● When you’re working with a stylus tablet, selecting 
Pen Pressure determines that as you increase the pen 
pressure you decrease the active width of the Mag-
netic Pen tool. 

	 peaches_sign.jpg

With its hard edges, rough-textured edges, and well-
defined contrast, the Georgia Peaches sign in the file 
peaches_sign.jpg is an ideal image to outline using 
the Magnetic Pen tool (Figure 17).

time more efficient and your paths more precise. The 
Add Anchor Point, Delete Anchor Point, and Convert 
Anchor Point tools are nested under the Pen tool.

The Freeform and Magnetic Pen Tool
The Freeform Pen tool is nested under the standard 
Pen tool, and using it is akin to drawing with a pencil 
on paper. You have no control as to where the anchor 
points are laid down, but you can fine-tune the paths 
and points with the Direct Selection tool. We don’t 
use the Freeform Pen tool very often because the time 
needed to refine the paths it creates would be better 
used to make a precise path with the standard Pen 
tool. On the other hand, the Magnetic Pen tool is a 
handy tool to use when you’re outlining images with 
distinct tonal differentiation and smooth edges.

When the Freeform Pen tool is active, select Magnetic 
in the Options bar to draw a path that snaps to the 
edges of defined areas in your image, similar to the 
way the Magnetic Lasso tool works. To control the 
Magnetic Pen tool, click the Settings Wheel, as shown 
in Figure 16 and explained here.

Figure 16  The Magnetic Pen tool controls.

The Magnetic Pen tool detects edges only within the 
specified distance from the pointer. To adjust the 
parameters of the Magnetic Pen tool, follow these 
instructions:

●● Curve Fit adjusts how sensitive to shakiness or 
amount of error the Magnetic Pen tool is. The default 
of 2 pixels means that if you veer two pixels offline, 
the Magnetic Pen tool will compensate and ignore 
that inaccuracy. Lower values require greater accu-
racy, and higher values are more forgiving but may 
create inaccurate results.

Figure 17  The sign is an ideal candidate for the Magnetic 
Pen tool and the settings we used when selecting it.
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1.	 Press Caps Lock to see the diameter of the area 
the Magnetic Pen tool is taking into account. Click 
the upper-left corner of the sign to set the first anchor 
point.

2.	 Without pressing the mouse button, drag to the 
right along the top edge of the sign. As you move the 
mouse, the Magnetic Pen tool snaps to the strongest 
edge in the image.

3.	 When you get to the right corner, click once to add 
an anchor point and continue down the side of the 
sign.

4.	 If the border doesn’t snap to the desired edge, click 
once to add an anchor point manually and to keep the 
border from moving. Continue to trace the edge and 
add anchor points as needed. If needed, press Delete 
to remove the last anchor point, as Katrin needed to 
do when the Magnetic Pen tool tried to include some 
of the dark lettering in the initial selection.

5.	 To temporarily change the Magnetic Pen tool to 
the Freeform Pen tool, press Option (Alt) to draw 
along the dark lower edge as needed. 

6.	 Complete the path by clicking the starting anchor 
point and naming the path (Figure 18).

Anatomy of a Path

The essential path components include:

l	 Hard anchor point. Marks a point along a path 
and does not have directional handles. Also referred 
to as a corner point or anchor point. Two of these 
points define a straight line.

l	 Smooth anchor point. On curved segments, each 
selected anchor point displays one or two curve 
handles. Sometimes referred to as a soft anchor 
point..

l	 Anchor points can be active (indicated by a solid 
black square) or inactive (indicated by a hollow 
square).

l	 Curve handles. The positioning of these curve 
handles determines the size and shape of the curved 
segment. Also called directional handles. Press 
Option (Alt) to adjust individual handles. 

To add and convert points:

l	 To add a corner point, click but don’t drag.

l	 To add a soft anchor point, click and drag in the 
direction you want the line to continue. This creates 
two handles, and the longer the arms of the handles, 
the greater the curve will be.

l	 To add a soft anchor point with one handle, 
Option-click (Alt-click) and drag to create a point 
with one handle leading forward.

l	 To convert a smooth point to a corner point, 
Option-click (Alt-click) on the point.

l	 To convert any anchor point to a two-handled  
smooth point, Option-click (Alt-click) and drag out.

l	 To convert a two-handled point into a single-
handled one, Option-click (Alt-click) on the end 
of the handle you want to delete and drag it so it is 
over the anchor point.

Figure 18  Always close and name the path before 
refining it.

	 	 tip   When the Magnetic Pen tool is not working 
as desired or when you just need to start over again, 
press the Esc key to delete the path in progress.
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Complex Paths and 
Combining Paths
Up to this point, you’ve learned to outline a single 
solid-shaped object with one path. But many objects 
have an inside and an outside. For example, the shape 
of a coffee cup consists of the actual coffee cup and 
the hollow handle area. Or, if you think of Superman 
standing broadly with his hands on his hips, ready 
to save the world, the Superman form is made up of 
his body and the three triangles of negative space 
formed by the two arms on his hips and widely spread 
legs. Believe it or not, many composites have failed 
or looked clumsy when the artist outlined the figure 
but forgot to outline the hollow negative spaces. As 
a result, in the composite the figure is in an environ-
ment, but the studio backdrop—for example, between 
the triangle formed by the figure’s arms or legs—is 
still visible. 

For practice, let’s separate the antique telephone 
(Figure 19) from the background and isolate it 
(Figure 20) for your image stock library. You’ll start 
by outlining the outside contour and then the inside 
contours that make up the shape of the phone. 

	 	 tip   When you’re using the Pen tool to outline 
complex shapes, keep one finger over the Option (Alt) 
key to change direction and press the Command key 
(right-click) to change the Pen tool to the Direct Selec-
tion tool to move an anchor point in progress.

	 telephone.jpg

1.	 With the Pen tool active, in the Options bar Path 
Operations select Exclude Overlapping Shapes.

2.	 Zoom to 100% or 200% view. Outline the outside 
of the telephone by starting on the top left of the 
mouthpiece. When you reach a corner where you 
need to move in a different direction, click to set the 
anchor point and Option-drag (Alt-drag) in the direc-
tion of the angled path to create a directional anchor 
point, as shown in Figure 21.

Figure 19  The original phone as photographed in a 
maritime museum. © KE

Figure 20  The isolated telephone is ready to be used for 
image stock or a composite project.

Figure 21  On distinct changes of direction, Option-drag 
(Alt-drag) to change direction and add an angle anchor 
point.
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3.	 Work you way around the entire phone and the 
outside of the cord. Close and name the outside path 
(Figure 22) Phone Outline.

4.	 With the outside path highlighted in the Paths 
panel, outline the eight individual hollow areas of the 
telephone as numbered in Figure 23. Notice that the 
icon of the existing path changes as you outline the 
hollow areas (Figure 24). Be sure to close each inside 
shape path before proceeding to the next one. 

Figure 22  Start by making and naming the outside path. 

1 2 3 4 5 6 7 8

Figure 23  Be sure to identify all of the hollow areas as 
numbered that need to be outlined and select Exclude 
Overlapping Shapes in the Pen tool options.

Figure 24  The hollow areas are clearly visible in the Path 
panel.

5.	 Activate the Direct Selection tool and zoom in on 
the path. Fine-tune the path by adjusting the position 
of anchor points and angle and length of direction 
handles. To delete extraneous anchor points, Control-
click (right-click) to bring up the context menu and 
choose Delete Anchor Point.

Making the path in and of itself doesn’t change the 
image. So after making a path, naming it, and saving 
the file as a PSD or TIFF file, you have a number of 
creative options for altering the image, as discussed 
throughout the book. To isolate the telephone, follow 
these steps:

1.	 Click the path in the Paths panel to activate it, 
return to the Layers panel, and Command-click (Ctrl-
click) the Add layer mask button to add a vector mask 
(Figure 25). 

2.	 Place a Solid Color Fill layer underneath the tele-
phone layer (Figure 26) or drag the telephone from 
the Layers panel icon to a background of your choice.

The beauty of the vector mask is that it allows you 
to refine the Vector mask path without changing the 
original telephone path. This means you can tweak 
and refine the outline based on how the telephone 
looks on the new background you placed it on. 
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To Specify How Overlapping Areas 
Interact
To control how paths interact where they overlap, 
take a few minutes to explore the Paths Operations as 
illustrated in this section. Create a path or select an 
existing path in the Paths panel, activate the Pen tool, 
and choose one of the following options as illustrated 
in Figures 27 through 30 in the Paths Operations in 
the Options bar.

Figure 27  Use Combine Shapes to add the new area to the 
existing path.

Figure 28  Use Subtract Front Shape to remove the 
overlapping area from the existing path.

Figure 25  The vector mask isolates the telephone 
perfectly.

Figure 26  A little color helps liven up the brown phone.

	 	 note   In Windows, JPEG, JPEG 2000, DCS, EPS, 
PDF, and TIFF formats support paths in Photoshop. In 
Mac OS, all available file formats support paths but in 
most cases we save our layered Photoshop files as PSD, 
PSB, or TIFF files.
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Figure 31  The original prototype catcher’s helmet and  
dual paths for the interior and exterior of the helmet.  
© Jim DiVitale (www.divitalephotography.com)

Figure 29  Use Intersect Shape Areas to restrict the area 
to the intersection of the new path and the existing path.

Figure 30  Use Exclude Overlapping Shapes to remove the 
overlapping area in the consolidated new and existing paths.

Figure 31 shows a catcher’s helmet that Jim DiVitale 
photographed, outlined with the Pen tool, and then 
colorized (Figure 32). As Jim explains, “There was 
only one prototype helmet available at the time of the 
photo shoot. Changing product prototypes is often 
an important part of post-production after a catalog 
shoot. The path for the helmet was tricky because 
there were areas inside the helmet that are the same 
color, which needed to be separated and protected 
before changing the exterior colors.”

Figure 32  The colorized catcher’s helmets are catalog 
ready.
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Working with Paths
After making and fine-tuning the path, it is time to 
do something with it! For photographers and compos-
iting artists, the most useful choices include: 

●● Convert a path to a selection

●● Combine paths with layer masks

●● Stroke or fill a path

●● Create image clipping paths 

Converting a Path to a Selection
Converting a path to a selection is the option we use 
all the time. The ability to combine Pen tool precision 
with selection flexibility is an almost intoxicating 
combination. 

To convert a path to a selection, use one of the follow-
ing techniques: 

●● With the desired path active in the Paths panel, 
click the Path panel Selection button on the 
Options bar.

●● With the desired path active in the Paths panel, 
click the Load Path as Selection button on the bottom 
of the Paths panel.

●● Drag the Path icon down to the Load Path as Selec-
tion button in the Paths panel.

●● Command+Return (Ctrl+Enter) to convert the 
active path to an active selection.

●● Command-click (Ctrl-click) the Path icon in the 
Paths panel.

●● Choose Make Selection from the fly-out menu on 
the Paths panel.

Once the path is a selection, you can use all of the 
finesse and controls discussed in Chapter 6, “Selec-
tion Fundamentals” and Chapter 9, “Layer Masks.”

	 	T ry It   The next time you’re in the studio or out 
taking pictures, make an effort to photograph objects 
that are ideal to practice using the Pen tool. Start basic, 
perhaps with a saltshaker, coffee cup, or geometric 
museum display, and then move on to more complex 
and involved subjects, such as decorative metal or stat-
ues (Figure 33 and Figure 34). 

Figure 33  The round pendulum clock is practically 
begging to be outlined with the Pen tool. © Wayne R. Palmer 
(www.palmermultimedia.com)

Figure 34  The curved metal offers a true Pen tool 
challenge. © Mark Beckelman (www.beckelman.com)
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Combining Paths with Layer Masks
When you’re selecting an object with elements that 
interact, such as objects with translucent attributes 
like the windows of a car or someone’s eyeglasses, it 
is best to outline each element with its own path. The 
advantage of having separate paths is that you can 
convert each path to a selection, which you can use 
in the layer mask to control density of the translucent 
areas with shades of gray. In the following exercise, 
we’ll treat the windows of a bomber plane differently 
than its solid body parts. 

To control image elements separately, it is very 
important that after creating and naming the initial 
exterior path you deactivate the initial path by click-
ing on the empty space below the named exterior 
path in the Paths panel before outlining the interior 
areas to create the paths for the windows. To separate 
the North American B-45A Tornado jet bomber from 
its environment (Figure 35), Katrin first outlined 
the plane and then made sure the plane path was not 
active when she created groups of paths for the rear, 

Figure 35  The original bomber is sadly tethered to the 
ground, as photographed at the Castle Air Museum in 
California. © SD

Figure 36  The composite allows the bomber to soar again.

mid, and front windows. Separate paths, which will be 
converted to active selections, enable you to control 
the density of the plane windows in the final compos-
ite (Figure 36). 

	 �plane.jpg © SD 
sunset.jpg © KE
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4.	 To complete the image as shown, save the file as a 
PSD file and open the Sunset.jpg file.

5.	 Double-click on the background layer of the jet 
bomber and name it Bomber. Drag the Sunset.jpg file 
onto the bomber file and position the sunset under-
neath the bomber.

6. 	 Return to the Bomber layer and activate the 
Outside of plane path. Click the Add layer mask 
button twice to isolate the plane on top of the sunset 
(Figure 40).

1.	 Outline the entire plane with the Pen tool and 
name it Outside of plane (Figure 37).

2.	 Make sure the plane path is not active by clicking 
in the Paths panel on the empty gray area under-
neath the named exterior path. Outline the interior 
of the cockpit windows, making sure to not include 
the frames (Figure 38) and name that path Cockpit 
Windows.

3.	 Deactivate the Cockpit Windows path by clicking 
on the empty gray area underneath the named paths. 
Use the Pen tool to select the pilot windshield and 
then gunner (the forward) windows to create separate 
paths for each (Figure 39). 

Figure 37  Working methodically and outlining each 
component will speed up the creative compositing work.

Figure 38  Outline the cockpit windows.

Figure 39  Outline the gunner windows.

Figure 40  Isolating the bomber onto the top of the new 
sunset background.
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	 	 tip   Vary the shades of gray used on the layer 
mask to control translucency and create a natural dif-
ferentiation between surfaces.

7. 	 To control the window density, Command-click 
(Ctrl-click) on the Cockpit Window path to create an 
active selection (Figure 41). Click on the layer mask, 
choose Edit > Fill, and use Black at 60% opacity to 
allow the sunset clouds to shimmer through the win-
dows (Figure 42). 

Figure 41  Convert the path to an active selection.

Figure 42  Filling the active selection with a shade of gray creates the illusion of transparency.

20 Photoshop Masking &  Compositing



9.	 As addressed in Chapter 13, “Photorealistic 
Compositing,” matching color is very important. 
One method to do this is to duplicate the light source 
layer—in this case the clouds—and place it above the 
object that has been placed into the scene. Blur the 
duplicate layer with a 25–50 Gaussian Blur, change 
the layer blending mode to Color, and reduce the 
opacity to 45% (Figure 45).

8.	 To control the density of the gunner (front 
window), Command-click (Ctrl-click) on the Gunner 
Window path to create an active selection. Click on 
the layer mask, choose Edit > Fill, and use 50% gray at 
100% opacity (Figure 43). By using shades of gray in 
the layer mask, the feeling of the glass windshield is 
maintained. If you move the plane to another part of 
the picture, the scene behind it will change appropri-
ately (Figure 44). 

Figure 43  Vary the shades of gray used on the layer mask 
to add realism.

Figure 44  Moving the bomber shows how effective the 
layer mask is.

Figure 45  Adding a hint of color to the scene allows the 
elements to come together. 

10.	To not color the clouds themselves, activate the 
Outside of plane path. Click the Add layer mask 
button twice to add a layer and a vector mask so that 
the blurred cloud color is only affecting the plane 
(Figure 46).

11.	To ensure that the plane’s logo is not colorized, 
outline the logo of the bomber (Figure 47). Com-
mand-click (Ctrl-click) on the Logo path to create 
an active selection, click on the cloud layer mask, 
and choose Edit > Fill with Black at 100% opacity 
(Figure 48). 

21Pen Tool Power



12.	Drop down to the bottommost sunset, choose 
Filter > Convert for Smart Filters, and experiment by 
adding Motion Blur to the clouds in the background 
to create the final image.

Creating separate outlines for important image ele-
ments allows you greater flexibility, and because they 
are so easy to combine, move, and activate, many 
photographers get in the habit of making one outline 
per path.

Color Fills
You can fill a path with solid colors (Layer > New Fill 
Layer > Solid Color) and gradients (Layer > New Fill 
Layer > Gradients), which in combination with blend-
ing modes gives you a fantastic and flexible method 
to experiment with images. By making a path for the 
canoe and then using three different Solid Color Fill 
layers with three different blending modes, you can 
change the color of the canoe from silver to green 
(Figure 49) or whatever color you desire. 

	 canoe.jpg

Figure 46  Controlling where the color takes place is easily 
done with the existing path for the plane’s exterior. 

Figure 47  Outlining the logo is the first step in isolating it 
from being affected by the color of the clouds.

Figure 48  Blocking the color from impacting the plane’s 
emblem is the right creative call.
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Figure 49  Changing the canoe from silver to green. © SD

1.	 Create a closed path for the silver canoe and name 
it Canoe.

2.	 Make sure that the Canoe path is active by clicking 
on it in the Paths panel.

3.	 In the Layers panel, click “Create new fill or adjust-
ment layer” and select Solid Color. 

4.	 The standard color picker will open, and you can 
choose a color. In this example, we chose a rich green. 

5.	 Change the Solid Color blending mode to Multiply, 
and reduce the Opacity to 40% (Figure 50).

6.	 Duplicate the Solid Color and change the blend-
ing mode to Overlay, which adds snap and contrast 
(Figure 51).

Figure 50  The Multiply layer is the base color.

Figure 51  The Overlay layer adds snap and offsets 
possible murkiness.

7.	 Duplicate the Solid Color one more time, change 
the blending mode to Color, and increase the layer 
Opacity to 65% (Figure 52).

8.	 Adjust the opacity of each Solid Color layer to 
refine the balance of color and contrast.
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The potential of using the Pen tool to precisely outline 
an object in combination with the flexibility of Fill 
layers may cause many sleepless nights of Photoshop 
experimentation and adventures. Thank you to Jim 
DiVitale for sharing this useful colorization technique 
with us! 

Stroking a Path
You can stroke a path with any of the painting, ton-
ing, and focus tools (Figure 53). In compositing, you 
can use the Blur, Burn, Healing Brush, and Clone 
Stamp tools to refine image edges—for example, to 
darken and soften areas to create contact shadows. 

Figure 54 shows a composite in progress that Katrin 
is working on. To give the edges of the watches more 
depth and integration into the wood, she stroked the 
paths around the rim of the tree trunks with the Burn 
and Blur tools as described next.

Figure 52  Colorizing with three layers allows for greater 
control and yields better results.

Figure 54  Darkening the edges where the watches touch 
the tree trunks supports visual coherency. © KE

Figure 53  Stroking a Path is an option for the painting, 
tone, and retouching tools.
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3. 	 Before burning the edges of the watch, Katrin 
double-checked the Burn tool settings and size. She 
used a soft-edged brush set to Shadows with 75% 
exposure. 

4.	 With the Soft Light neutral layer on top of the lay-
ers stack, she clicked the Top Trunk path, and on the 
Paths panel fly-out menu, she chose Stroke Path and 
then selected the Burn tool (Figure 57). 

1.	 After creating the initial composite, Katrin used 
the Pen tool to outline the interior of each tree trunk 
(Figure 55) and of course named the individual paths. 

2.	 To darken the edges of each watch and allow the 
watch to blend in more naturally, Katrin added a Soft 
Light neutral layer by Option-clicking (Alt-clicking) 
on the “Create a new layer” icon (in the Layers panel), 
choosing Soft Light, and selecting Fill with Soft-
Light-neutral color (50% gray) (Figure 56).

Figure 55  Taking the time to create and name all the 
required paths allows you to concentrate on the creative 
aspects of the image.

Figure 56  Setting up the Soft Light neutral layer for the 
shadows.

Figure 57  Double-check which tool the Stroke Path 
command will apply to.

	 	 note   Photoshop will reference the last painting 
tool you modified to be the tool that it uses to stroke the 
path. You can always use the pull-down menu to choose 
any of the other painting, toning, retouching, and focus 
options. 

5.	 Katrin then clicked OK. Photoshop stroked the 
active path with the selected tool. She repeated the 
stroking of the path two or three times with the Burn 
tool until the shadow was visible and also stroked the 
Path with the Blur tool to soften the shadow a bit. 

6.	 To strengthen the effect, Katrin duplicated the Soft 
Light layer and adjusted the layer Opacity to suit the 
image and her personal aesthetic.

Figure 58 shows a close-up comparison of the watch 
edges without and with the darker edges. The effect 
may be subtle, but subtle is the name of the game, 
because you don’t want the effect to be the subject of 
the image.
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Figure 58  Without and with the shadows around the 
edges of the watches.

Creating Image Clipping Paths
You see images that are clipped all the time—the 
silhouetted washing machines or the bananas in the 
“two pounds for one dollar” advertisements in the 
junk mail that fills your (analog) mailbox. 

Image clipping paths, commonly referred to as 
clipping paths, are vector-based information of the 
outline that is smoother than a pixel-based selection. 
Most important, image clipping paths are printed at 
the output resolution of the PostScript output device, 
so the edges will be very crisp.

Figure 59 shows a photograph of a camera lens that 
Katrin needed to feature in an article. The back-
ground is distracting, and the lens would stand out 
more if it were isolated on the page with a clipping 
path (Figure 60). 

	 camera-lens.jpg 

To create an image clipping path, follow these steps:

1.	 With the Pen tool, outline the object you want 
silhouetted, and name the path lens (Figure 61).

2.	 On the fly-out menu in the Paths panel, choose 
Clipping Path.

3.	 Choose the path from the drop-down menu, and 
type in 4 for a Flatness setting (Figure 62). Notice 
how the name of the path is bolded (Figure 63).

Figure 59  The original photograph. © KE

Figure 60  The clipping path isolates the subject, allowing 
it to be more prominent. 

26 Photoshop Masking &  Compositing



4.	 Save the file as a TIFF or EPS. When you import 
the file into Adobe InDesign, the object will be per-
fectly silhouetted.

After converting a path to a clipping path, you can 
still use it just like a “normal” path and refine it, 
stroke it, fill it, and convert it to a selection. 

Combining and Moving Paths
As you create more and more paths, you’ll find that 
you have a path in one file that would be useful in a 
different file. Rather than redrawing the path, you 
can drag and drop the path from the first file to the 
second. Moving paths is a practice frequently used in 
studio still-life photography, such as when a photog-
rapher makes a path of an object and then decides to 
work with a different frame of the same object.

To move the path from the first file to the second, 
use the Path Selection tool (black arrow) to activate 
the path you need to transfer, and then drag the path 
from the image or the Paths panel into the target file. 
Photoshop will add the path to the active path, or 
if no path existed before, create a path that you can 
then name.

If the path doesn’t fit perfectly, use the Direct 
Selection tool to select the points that need refine-
ment. Choose Edit > Free Transform Points, press 
Command+T (Ctrl+T), and transform the path into 
place to create the final path. When the second path 
is completed, duplicate it by dragging it down to the 
New Path button in the Paths panel and then refine it 
for the next layer. 

For each layer, start with the path from the previous 
layer and refine it by transforming, adding, or deleting 
points, and bending the direction lines into position 
until each layer has a corresponding path. 

	 	 tip   When you are copying and pasting or drag-
ging paths between files, both images must have the 
same pixel resolution for the path to fit the target image.

Figure 61  The initial named path.

Figure 62  Use a standard tolerance setting for very good 
results.

Figure 63  The name of the clipping path is bolded, but you 
can still work with it like a standard path.

	 	 tip   The higher the value, the straighter and pos-
sibly choppier the curves will be, but as David Blatner 
explains, “You can almost always raise your Flatness 
setting to between 3 and 5, never see the difference, 
and speed your printing times considerably.” From the 
Adobe Help menu: The lower the flatness value, the 
greater the number of straight lines used to draw the 
curve and the more accurate the curve. Values can 
range from 0.2 to 100. In general, a flatness setting from 
8 to 10 is recommended for high-resolution printing 
(1200 dpi to 2400 dpi), and a setting from 1 to 3 for low-
resolution printing (300 dpi to 600 dpi). 
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Artist in the First Person  Jim DiVitale, Diversity and Detail Master

Katrin first met Jim DiVitale in the mid 1990s while 
she was visiting The Creative Circus, the art school in 
Atlanta, Georgia, to present her favorite Photoshop tech-
niques. As any public speaker will tell you, connecting 
with your audience is crucial, and on this day the energy 
on the room was very high. But off to her right was an 
extra special spark of a man with a flash in his eyes and 
a big smile on his face. She couldn’t help but notice that 
this man, who turned out to be Jim DiVitale, was really 
enjoying the session, and more important, was already 
thinking about how he could apply what he was seeing to 
his own photography. Afterwards Jim introduced himself, 
and since then Katrin and Jim have been Photoshop 
colleagues whose paths often cross at major confer-
ences where now Jim is the star speaker to hundreds of 
Photoshop aficionados.

Jim is the picture of professional diversity; he has been 
an Atlanta commercial photographer and instructor 
for three decades, specializing in product photogra-
phy and digital photo illustration. He is a PPA Master 

Photographer, Master of Electronic Imaging, Photo-
graphic Craftsman, Fellow of the American Society of 
Photographers, onOne Master, Team NIK member, 
X-Rite Coloratti, and a Canon “Explorer of Light.” Addi-
tionally, Jim is an instructor and contributing columnist 
for The National Association of Photoshop Professionals. His 
award-winning advertising photography has been fea-
tured in many magazines, including Graphis Photo, Print, 
Archive, Create, Creativity, Rangefinder, Professional Photog-
rapher, Digital Output, Digital Imaging, Photo District News, 
and After Capture. His clients have included Mizuno USA, 
Rubbermaid, Remington Medical, SmartSynch, Canon 
USA, William Carter Co, Toshiba, Time Warner Cable, 
TEC America, Kenneth Cole, Bellsouth, BP Amoco, COX 
Media, Genuine Parts Company, Adobe Systems, Solvay 
Advanced Polymers, Witness Systems, JP Morgan Finan-
cial, Coca-Cola USA, and Scientific Atlanta.

But more impressive than his biography is Jim’s ability 
to problem solve. As he explained, “I know a job is going 
to be a tough one when my art director starts laughing 

Figure 64  Jim shot many, many pour shots with the glasses and then combined the best parts of each one with the bottle 
image to create the final feature ad. © Jim DiVitale
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before he explains the details and changes needed. 
Often, the clients know that they are asking the almost 
impossible, but I love a challenge. For me, the best part 
of the photo shoot is figuring out how to break down the 
shoot into the needed components, shoot them prop-
erly, and then use Photoshop to put the image together 
(Figure 64).”

Jim looks back and shares how he was introduced to the 
Pen tool. “I learned in my very first Photoshop class in the 
early ’90s that the Pen tool was one of the most powerful 
tools in the program and have believed in that ever since. 
Coming from years of large-format, in-camera masking 
and pin registration darkroom assembly, the Pen tool was 
the single most important new tool to work with to make 
perfect transitions between photographic elements.”

In addition to being a successful commercial photog-
rapher, Jim finds the time and needed balance to work 
on his fine-art photo illustration work, which is a direct 
contrast to the highly defined and detailed work required 
during his “day job.” 

Jim clearly explains his lifelong interest in photography: 
“From my first rolls of film in high school photography 
class, I’ve been compositing elements together to create 
what I see in my head—first by sandwiching negatives, 
then double exposures, multiple cameras, enlargers, or 
whatever ever it took. The computer just put all of that 
into hyperdrive by changing the tools to accomplish 
the same goals. Things I see become parts to images 
that I am working on in my head. I give myself many 
self-assignments to create series of images that work 
together as a theme. They can come together quickly, or 
it can be years before certain elements snap into place 
on an image. They are all works in progress. It just makes 
me feel good to create art in this way.”

Recently, Jim completed a collaborative project with 
author Doug Frey, which consisted of beautiful architec-
tural photographs (Figure 65) of the historic homes of 
Marietta, Georgia. The photographs were exhibited and 
featured in the book Marietta, the Gem City of Georgia: A 
Celebration of Its Homes–A Portrait of Its People, a 432-
page coffee-table book published by Cobb Landmarks 
and Historical Society. The three-year-long photography 
project yielded 235 GB of location photography, and as 
Jim shared, “Working in black and white and shooting 

architecture are both out of my daily comfort zone of 
working in the studio on product photography, but it was 
fun and quite an eye-opening experience to complete the 
book and exhibition. Using the Canon1Ds MIII camera 
and assorted tilt/shift lenses, the images were created 
using multiple exposures and merged to HDR files before 
converting to black and white.”

Whenever Seán or Katrin meet Jim at the Photoshop 
World Conferences, they know that he will have a smile 
on his face and take the time to say hello (and mean it). 
Jim is always learning, exploring, and looking for bigger 
photographic challenges. We should all remain as curi-
ous, open, and excited about photography and creativity 
as Jimmy D (www.divitalephotography.com).  ■

Figure 65  The historical homes of Marietta, Georgia, 
was a long-term project Jim collaborated on with author 
Doug Frey.
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3.	 Name the path and use the Direct Selection tool 
(the white arrow) to refine the path as needed.

Figure 68 shows the path that Photoshop created 
from the selection and the path that Katrin made and 
refined in about 60 seconds. As you can see, the hand-
made path has fewer points and is more accurate.

Converting Selections to Paths 
It makes sense that if you can convert a path into a 
selection, you can also convert a selection into a path. 
Katrin isn’t a huge fan of this technique because the 
paths are often very rough with too many points and 
require too much refinement to make the resulting 
paths very useful, but it has helped enough people for 
us to include it here. 

	 awl.jpg © KE

1.	 Select the awl with the Quick Selection tool (as 
shown in Figure 66 and) as described in Chapter 6.

2.	 Open the Paths panel and click the fly-out menu. 
Choose Make Work Path, which will bring up the 
Flatness dialog. Type in a Tolerance setting of 1.0, 
and click OK (Figure 67). 

Figure 66  Start with a Quick Selection of the bookmaker’s 
awl.

Figure 67  The Tolerance setting determines how accurate 
the path will be: The higher the setting, the less accurate the 
path.

Figure 68  The Path created by the selection has too many 
anchor points to be very effective, but the hand-drawn path 
is very smooth.
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Closing Thoughts
We hope that by reading this chapter and practic-
ing the techniques in it that you have banished the 
lurking Pen tool monster from your Photoshop list of 
tools to learn. Throughout the book, you’ll use paths 
and the Pen tool to refine edges, create silhouettes, 
and make alpha channels that are elegant and precise. 
Enjoy!

	 	 note   Paths add only 4 Kb to 6 Kb to a file, mak-
ing them wonderfully efficient. But because of their tiny 
file size, many people assume they should convert their 
alpha channels to paths to save file size. This is an urban 
myth that needs to be squelched wherever it raises 
its misunderstood head. Photoshop uses an efficient 
run-length encoding scheme to describe the masks, so 
when the file is closed, the masks hardly add anything 
to the file size. In addition, if you convert gradated alpha 
channels to paths, you will lose the smooth edges and 
tonal transitions.
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